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Chapter 1

What's New...
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1.1 ScanStudio HD 1.2.0
ScanStudio HD 1.2.0 get it here: ->
64 Bit Architecture:
* ScanStudio HD is now a full 64 bit native application.
* Dramatically larger memory resources for large scan jobs.
* NOTE: Please uninstall all 32 bit ScanStudio versions prior to installing ScanStudio HD x64.
Windows 7 Compatibility:
* ScanStudio HD now operates fully under the latest Windows 7.
* Please reduce your UAC setting to allow ScanStudio HD licensing.
Next-Generation Algorithms:
* New technology for FUSE, MERGE, ALIGN, and POLISH algorithms.
* The new algorithms improve model quality, work faster, and use less system memory.
New Scan Panel:
* Simplified, cleaner user interface.
* Faster and more responsive to user input.
* Enhanced MultiDrive controls.
Revised User Interface:
* Completely overhauled to leverage the latest Windows UI technology.
* Speed and snappiness of the application is greatly improved.
MultiDrive (2-Axis) Support:
* MultiDrive provides for automated multi-axis Scanning and Alignment.
* To see the MultiDrive in action check out the "What's New" section of the NextWiki or click here:
* For more information contact info@nextengine.com or start a chat to speak with an Application
Engineer.
NextWiki Support Center:
* NextWiki now works in its own independent, concurrent window.
* Allows for easier access to support media and live chat with Application Engineers while using the
application.
Corrections & Updates:
* Improved installer for better driver compatibility.
* New User Manual included w/ ScanStudio HD.
* Scan Panel model name issues resolved.
* ScanStudio HD hang upon close is corrected.
* "Generating Points" bug is eliminated.
* Scanner USB connection robustness improved.
* Improved Auto Alignment algorithms for AutoDrive and MultiDrive.
* New status indicators.
* Many more quality advances.
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IMPORTANT: Microsoft Dot NET 3.5 Required:
* To run ScanStudio HD 1.2, .NET 3.5 needs to be installed.
* .NET 3.5 comes standard w/ Windows 7 and Vista.
* Download it here: http://download.microsoft.com/download/6/0/f/60fc5854-3cb8-4892-b6dbbd4f42510f28/dotnetfx35.exe
Thanks for your support,
NextEngine Development Team
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1.2 MultiDrive
Setup
MULTIDRIVE SETUP
-Here are the items that are included with the MultiDrive

Allen wrench and

L Bracket

AutoPostioner

-Attach the L Bracket to the MultiDrive with two flat head screws and allen wrench

-Attach the MultiDrive to the bottom of the scanner and fasten a screw underneath the scanner for
additional stability
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-Plug in the MultiDrive to the scanner

-Start ScanStudioHD and proceed to Calibration

Calibration
CALIBRATING THE MULTIDRIVE

When starting your first scan in

-"Start" to begin the automated calibration process (We suggesting using the palm tree included with
the MultiDrive)
-"Skip" if you wish to proceed to the scan panel and choose
-"Learn More" to be directed to this help page.
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You can

-This function is available for re-calibration when alignment results in an error or when the MultiDrive
was detached and is reattached.

Scan Process
SCANNING PROCESS

After calibration is

A new scan panel will be loaded when

-Five families are now available for predefined settings for Positioning, Divisions, Start Angle, Tilt
Angle, Points/IN^2 and Target
-Clicking on the family name will enable the tab to edit the settings.
-To enable or disable a family, simply check or uncheck the circle next to the family name.
-Starting positions can be set for both the initial and tilt axis by moving the slider bar arrow.
-The start axis has the full 360 rotation and tilt axis is bounded to -35 to 45 degrees.
-Use the top slider bars to visually set the starting and tilt positions. (This will update the settings for
the scan family)
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-Select the scan settings for each tab and check the tabs you want to have scan.
If the setting for a tab have been adjusted, but the tab is not checked it will not scan.

-All MultiDrive scans are to be in MACRO mode.
-Select a ROI for your model to prevent the MultiDrive from being scanned in for certain tilt angles.
-If additional scans are needed, enter scan panel and position the model by using different starting and
tilt angles to capture additional scans.
-If you physically adjust the part, then a 3 pin alignment will be needed to align.
-When finished, trim unnecessary data and "Fuse" or "Volume Merge" the model for export: ->

Troubleshooting
ADDITIONAL TIPS AND TOOLS
Switching between AutoDrive and MultiDrive
- Simply plug in an AutoDrive to display the proper UI.
- When reattaching the MultiDrive, make sure to recalibrate as needed.
-When more than 5 Scan families are required, then just click on scan to enter the scan panel, and you
can add 5 more new sessions. These scans should auto align to the previous scans assuming all the
movement and rotations were done by the turntable. If they don't auto-align , just drag the scans into
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the green and refine (no pins required)
-Force Calibration. If your scans are not coming in aligned, you may need to run a force calibration.
You can do this from the drop down menu , Align, then go down to Calibrate MultiDrive

Dental
DENTAL
Recommended Scan Settings for Dental Cast Models

Family A Divisions: 6 Tilt: -10
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Family B Divisions: 6 Tilt: 45 degrees

-Use the HD speed for higher resolution
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Chapter 2

Getting Started
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2.1 System Requirements
PC
The 3D Scanner HD is a high resolution device, and quickly captures many millions of points and
pixels. A powerful PC is key for being able to visualize and take full advantage of this data.
Minimum PC Requirements:
CPU: 2GHZ PC (Single Core)
Memory: 2GB RAM
GPU: 128MB Graphics Card (Dedicated, non-integrated)
OS: Windows XP
USB 2.0
HDD: 10GB Free Space
Recommended PC Configuration:
CPU: Dual Core processor
Memory: 4GB RAM
GPU: 512MB Graphics Card (Dedicated, non-integrated)
OS: Windows x64 (XP, Vista, 7)
USB 2.0 Powered Hub
Note:
If you are going to be scanning large or complex models, we highly recommend running a 64bit OS
and upgrading your RAM to at least 4 GB.
For a fast viewing experience, a good graphics card is essential. In our testing we've found that not all
GPU's are optimized for dealing with lots of points and pixels.
Quick tip for a new Graphics Card: The latest and greatest is the nVidia GeForce GTS/GTX series.
They are well priced and can handle large amounts of scan data smoothly. The GeForce GTS/GTX
series is available on Newegg with a price range of $115 to $300.
If you have questions about your system configuration, we'd be happy to help. Please note the SD
scanner is only compatible with Windows XP and Vista when you are running as the administrator.
All software developed after ScanStudio CORE is only for HD scanners. If you would like to upgrade
your SD scanner please contact NextEngine at info@nextengine.com.
Please click "Ask?" to talk to us about it.

USB
The scanner requires a USB 2.0 connection.
Here's how to check if you have USB 2.0 support, which is required to run the Desktop 3D Scanner.
- Right-click My Computer
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- Click on Properties
- Click on the Hardware tab
- Click on the device Manager button

- Scroll down as needed until you see Universal Serial Bus Controllers
- Expand that by clicking on the boxed plus sign in front of Universal Serial Bus Controllers

If it says "Standard Enhanced PCI to USB Host Controller" it is 2.0. If it does not say "Enhanced" it's
USB 1.0.

PC Buying Guide
It's now possible to purchase a PC with great scanning, CAD, and graphics performance for under
$1000.
We've found that the best combo in terms of price / performance is to assemble the computer from
scratch, purchasing individual parts. For a ready made PC, options such as Dell and HP will let you
choose individual components to meet your needs.
Some tips are provided below for finding the best deals (as of November 2009). We don't have a
relationship with any of these vendors, but this is how we buy most of our test hardware.
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Go to Newegg.com and check out their latest deals.
Look for a Intel Core2 Quad Processor. These are the some of the best processors currently available,
and are dropping in price significantly.
Intel Core2 Quad Q9400 - 2.66GHz 6MB L2 Cache - LGA 775 95W
Price: $190
http://www.newegg.com/Product/Product.aspx?Item=N82E16819115131
Upgrading the RAM:
For stable performance when capturing complete models, 4 GB of RAM is recommended. One
example:
4 GB DDR2 PC2-8500 RAM
Price: $89
http://www.newegg.com/Product/Product.aspx?Item=N82E16820231166&cm_sp=DailyDeal-_-20231-166-_-Product

Upgrading the Graphics Card:
We've found that the nVidia GeForce GTS/GTX series are well priced and can handle large amounts
of scan data. We've also found that SolidWorks and other CAD programs work quite well with these
cards. Here's a well priced sample from Newegg.com
nVidia GeForce GTS 250 - 1GB of RAM
Price: $150
http://www.newegg.com/Product/Product.aspx?Item=N82E16814150439
**Make sure to download the latest driver for your Operating System**
The ATI FireGL cards are also recommended. They have great price/performance. We do not
typically recommend purchasing a nVidia Quadro for this application. This is because only the highend Quadro models have sufficient processing power to handle large numbers of 3D vertices.

Support Operating Systems
ScanStudio HD 1.2 runs on Windows x64 operating systems, including the new Windows 7 x64.
ScanStudio HD 1.2 offers a full 64 bit application.
ScanStudio Core with the SD scanner is only compatible with Windows XP and Vista (with
administrator rights).
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2.2 Software Installation
Download
Please uninstall 1.7.3 before installing ScanStudio HD.
- Go the ScanStudio Quick Start Page at http://www.nextengine.com/start
Link to the Download for ScanStudio HD 1.2.0 ->

Enter your e-mail address and password

- You can find your username and password in the order confirmation e-mail. If you need your account
information please e-mail info@nextengine.com
- Choose to SAVE the file.
After download is complete, double click the installer file to start Installation.
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Accept the License Agreement and click

It is recommended to install in the

Every box should be checked and then
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Click to Install the Software

The latest version of .net is required to

Make sure the scanner is unplugged
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Once Installation is complete click

- For an SD scanner and ScanStudio 1.7.3 you will need to be logged in as an administrator to install
and run the software. For HD scanners running HD 1.1.0 and newer you do not need administrator
privledges on the computer.

Connect
- Connect the scanner to the computer's USB port

- For XP and Vista a window will appear alerting you that new hardware has been detected.
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Select option to Install the software

When the wizard has completed the

- For Windows 7 the drivers should automatically install once you plug in the scanner.

The scan arrow

Online
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If you are connected to the internet activation is very simple.

You will be asked to sign-in the first

- If your computer is connected to the internet it should automatically detect your computer and
validate your ScanStudio license.
- Go to Help, About ScanStudio to see which version of ScanStudio you are running
- Click on Support and go to My Software to see your license status.

Offline
You do not need an Internet connection to use ScanStudio.

If your computer is offline you will see this

- Please go to this link http://support.nextengine.com/license/setup.
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Enter in the requested machine information

Your license will be e-mailed to

- Transfer the license file to your offline computer via a USB drive.
- Save the license file on your computer.
- Click the license file to launch ScanStudio.

License
ScanStudio Core or HD Licensing:
- Core or HD can be installed on multiple computers.
- If your scanner says HD on the front you will want to run HD, if not run Core.
ScanStudio CAD Tools and HD Pro Licensing:
- CAD Tools and HD PRO are assigned to a single username and can only be used on one computer
per license.
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To activate, click where it says OFF and then it will say Activating followed by

License Transfer Procedure
- Click on Support inside of the application.
- Go to My Software
- You need to turn the software OFF on the old computer before activating it on a new machine.
*If you have a question about your license please click ASK and someone from technical support will
help you.
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2.3 Hardware Installation
Scanner
Installing the Scanner:

- Get your USB and power cords out of box

- Plug power cord into outlet and back of scanner

- Plug USB cord into back of scanner and computer USB port
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Note: USB 2.0 is required to handle the large volume of 3D data and images.

AutoDrive
Setting up the AutoDrive and PartGripper:
AutoDrive

PartGripper

- Screw PartGripper into one of four corner sockets on AutoPositioner
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- Tighten Platter on PartGripper

- Rotate Post clockwise (about 6 turns) to tighten PartGripper into AutoDrive

Tripod
Scanner and Tripod

There is a screw hole on the bottom of the scanner for attaching the scanner to a tripod
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Next Step: Download and install ScanStudio -> or if already installed start your first scan
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2.4 Customizing ScanStudio HD
File Management
-Each new scan is named 3D_Scan_## where the ## gets incremented to ensure a unique filename for
each new scan.
-When you capture the first scan in a model, you can specify the filename by entering it in the yellow
status area in top bar of the Scan Setup Panel:

-A new folder will be created in your scan results directory with the specified name. Your SCN and
JPEG files will be saved into that folder as the scan is captured.
-When you do a File-Save As, ScanStudio will save all of the needed files (SCN, JPEGS, etc.) into the
directory you select, so you should be able to delete the 3D_Scan_## directory once you've done a
File-Save As.
-File-Save should save your current SCN file wherever it resides, so it should save into the
3D_Scan_## directory unless you have performed a SaveAs or named the model at scan time, at which
point it would save into your specified directory.

Preferences
-The Application Preferences Dialog is available from the Edit-Preferences menu and can be used to
customize ScanStudio to fit your usage
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Scan
-By default, the scan save directory is located under your My Documents\My 3D folder under your
username.
-You can customize the directory after installation
Polish
-Turn On/Off Model Backups which can be used to undo changes and restore from corrupted files
-Optionally display a settings dialog as part of AutoTrim
-Turn On/Off the unloading of models while Polish to help save memory
2D Texture Display
-Enable/disable texture loading and display (can be disabled to save memory).
-If it is disabled your model will only be displayed in solid mode.

Performance

Click on Performance to select additional
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Prompt to Upgrade Memory
-Optionally check your system for the minimum RAM needed to run ScanStudio (a warning is
displayed at application startup if your system does not meet the 2GB min. requirements)
Prompt to Upgrade Graphics Card
-Optionally check your graphics card and warn if it is not compatible with ScanStudio (a warning is
displayed at application startup if your graphics card is not supported).
Enable/disable graphics card caching for higher rendering performance.
Monitor Hardrive Space
-Optionally monitor your free hardrive space and warn if your system is running low.
Monitor Memory Usage
-Optionally monitor the amount of available memory (RAM) and warn if your system is running
low.
Graphics Card Caching
-Enable/Disable graphics card caching.
-If you have an ATI graphics card and experience USB issue you will want to turn this off.
-If you are working with large models and are having a slow response moving the model on the screen
you will want to enable this.
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Chapter 3

Scan Process
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3.1 Setup
Surface Prep
Prepare dark, shiny or transparent objects using included tools to help the lasers capture the data.

Paint Pens: Washes off most

Powder: Talc

Testing has also shown that a spray powder like Magnaflux Spotcheck SKD-S2 Developer works
well for prepping objects prior to scanning.
Here is a link to the site where you can purchase. Magnaflux Buy Page

Magnaflux Spotcheck

Other spray alternatives such as foot powder spray or white hairspray can be used as well:
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Foot powder spray from

White Hairspray

White Hairspray Buy Page

Alignment Prep
It may be helpful prior to scanning to make alignment marks using the alignment pen. These marks
will make it easier to place pins and identify locations on the object. Alternatively, the 3D geometry
that the Scanner captures can be used to align scans.
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3.2 Controls
Mouse Controls

- Right click to zoom.
- Left click to rotate the model.
- Hold down the left and right buttons together to pan.
- Use the center scroll button to pan without selecting an area during trim.

Starting and Stopping
- Click the Start button to run the scan

- Click the Stop button to stop the scan

NextWiki Support Center
The SUPPORT button will take you to the NextWiki Support Center.

Click on
32 of 120

Browsing
- Click on the Close button to close a scan before starting a new project

- Click on the Browse button to open a previously saved scan
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3.3 Scan
Intro
- Enter the Scan Panel by clicking the Scan button

- Customize your scan name in the yellow toolbar

There are 3 main types of scans:

360:
- Select the "360" scan option in the scan panel to scan the object from every angle.
- The number of divisions will control the degree of rotation between scans and the total number of
scans
- The individual scans will be grouped as a family.
Bracket:
- Select "bracket" scan in the scan panel to scan three consecutive angles.
- The number of divisions will control the degree of rotation between scans
- The three scans will be grouped as a family. More on Scans and Families
Single:
-Single scan of the object from one angle.

Speed
Precision:
Choose MACRO or WIDE distance based on object size and desired resolution
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Macro = 0.005" accuracy, 3x5" field of view
- Place object 6.5 inches from the front of the scanner
Wide = 0.015" accuracy, 10x13" field of view
- Place object 17 inches from the front of the scanner
Extended = 0.015"+ accuracy, 16x22" field of view
- Available with HD PRO
- Objects can be placed up to 30" from the face of the scanner
Speed:
ScanStudio CORE
Choose Standard, Quick or Fine scan speed based on desired scan time and quality

ScanStudio HD/HD PRO

Macro Reference Table
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Wide/Extended Reference Table

Tips
- For ScanStudioHD, go to Scan -> Settings -> Texture Capture Mode - and choose Monochrome for
faster scan speed.
- Choose Fine or HD Speed for the greatest resolution.
- Choose Quick Speed to capture data the quickest with lowest resolution (not recommended for most
parts).

Position
- Orient object in viewfinder using Rotate buttons
Turn/Step Arrows:

- One click on a Turn Arrow rotates the AutoDrive a single increment for more precice positioning.
- One click on a Step Arrow rotates the AutoDrive one division.
- For example, if the divisions is set at 4, clicking on the step button will rotate the object 90 degrees.
- The left arrow rotates the object clockwise.
- The right arrow rotates the object counterclockwise
Note: The AutoPositioner should only be rotated using the Rotate Arrows and should not be done
manually.
Region of Interest
- Drag the cursor around the object to select a smaller scan area
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Regenerate
- Since the raw scan data is saved at scan-time, you can regenerate the points at any time with different
point-generation settings.
- These settings have the same effect as the sliders on the scan setup screen.
- Re-Gen is particularly useful for changing the decimation value after a scan has been completed.
Steps:
- Click on Fuse, Re-Generate Scan(s)

- Select new scan settings for reprocessing

- Restore Trimmed Data: Choose this option to restore the trimmed data from either a single scan,
family or the entire model.
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Next Step: Remove unwanted areas such as the PartGripper using Trim or Align your scans to make a
complete model -> . For tips on viewing your scan ->
- If you have any further questions, please click on the Ask? button.
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3.4 Align
Intro
Note:
- Prior to scanning, it may be helpful to make alignment marks using the alignment pen.
- These marks will make it easier to place pins and identify locations on the object.
- For the Palm Tree image below, the markings on the model can be used for our reference points.

Selecting Scans to Align
- Double click on thumbnail of a family to separate the family into individual scans

Alignment Screen

Click on Align to enter

- When you enter Alignment, you'll see a split screen view
- The left side shows an assembly of scans/families that are already aligned
- The right side shows the next piece that you're attaching to that assembly
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Thumbnail Bar

- The green side contains scans and families that are already assembled
- The blue side is for pieces that aren't part of the assembly yet
- To break apart or assemble your model, simply drag parts from one side to the other

Single Family
Alignment for 360 or Bracket Scans
- Place 1 pin on a common location between 2 scans within the family.
- Drag the pin to the location or double click on the point to place the pin.

Attach Scans
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- The yellow status bar will walk you through the process
- Click "Attach Scans" to add your scan to the assembly

- Click File > Save after each alignment in order to save pin locations
- You can detach a scan by dragging it from the green to the blue and then you can adjust the pin.
AutoAlign
AutoAlignment uses previous AutoDrive alignment information to position the scans relatively close
then refines the alignment to accurately align scans using the AutoDrive as they are captured, without
requiring any user input.
AutoAlignment will result in accurate alignments if the AutoDrive and Scanner are close enough to
the same relative position as the last manual turntable alignment (for each depth range).
For Example:
- Start up the scanner for the first time and place the turntable where you want it.
- Do your first scan and manually align by placing pins.
- Then if you scan again either that object or a different object without moving the turntable with
respect to the scanner it will auto-align.
- You can then restart ScanStudio or start a new scan and as long as the turntable is not moved it will
auto-align.
- If AutoAlignment does not result in an accurate alignment, the standard Align tool can be used to
place correspondence points and align the scans.

MultiFamily
- Multiple families can be aligned together.
- Place 3 pins on common locations between the 2 families
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Two pins placed in front

Third pin placed in back

Attach Scans
- The yellow status bar will walk you through the process
- Click "Attach Scans" to add your scan to the assembly

- Click File > Save after each alignment in order to save pin locations
- You can detach a scan by dragging it from the green to the blue and then you can adjust the pin.
Next Step: Once it's all put together, learn how to trim and fuse your scan data ->

Align Settings
Advanced Settings
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Max Iterations
-Input a value which limits the number of times of iteration of the fine alignment.
Sample Ratio
-1/1, 1/4, 1/9, 1/16, 1/25, 1/36, 1/49 and 1/64.
-If you are dealing with a large data set, you may sample it. Doing this, the registration result won't be
sacrificed, but the processing time greatly decreases.
Ignore Outlier Verticies
-If checked, data which is far from the average will be ignored during calculation.
Allow only small transform
-The entire overlapped region is considered while assuming that the initial alignment is already well
done.
-It is recommended to check this option if there are few geometric features in the overlapped region.
Fixing Scans
When aligning multiple families it may be beneficial to lock the individual families in place so that
any future alignment does not disrupt the already aligned families.
Fixing a Single Family
-After your single family alignment is complete (double click on the family if you need to expand it
out), then go to Align, Settings.

-Check the box "Fixed (will not be moved by alignment)" for scans A1-An. This will lock the
individual scans in the family and not be moved with future alignment.
-If you check the Fixed button for the Family A tab, then this will lock the entire family in place and
not just the individual scans for that family.
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Fixing Multiple Families
-For multiple families, go to Align, Settings and check the box "Fixed (will not be moved by
alignment)" for the families that have been sucessfully aligned and wish to be locked in place.

Example:
- Starting out with three families (One 360 and two brackets)
- Attach Family A to Family B (both families are not fixed)
- Go to Align, Settings and check "Fixed" for Family A and Family B (They are now locked in
position)
- Proceed to attach Family C to A and B.
- After C is sucessfully aligned, then go to Align, Settings and fix Family C
- Repeat for any additional family attached.
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3.5 Trim
Intro
- Back up your scan file as a different copy unless ScanStudio has not done so already.

Click the 'Trim' button in the

- Click the cirlce/square/square selector/poly selector button in the toolbar to select data

- Select the area on the scan to be removed and continue selecting until all unwanted area is
highlighted
- To remove selected area, click on the "Trim" button in the toolbar
- Continue the process until all unwanted area has been removed

Before Trim

After Trim

Deselecting
- If an area is incorrectly selected it can be deselected before trimming takes place.
- To deselect an area, click on the "minus sign" in the toolbar, which will turn the selectors to blue

- Then click on the area to be deselected.
- Click on the "plus sign" in the toolbar to return the circle/square to red and resume selecting area to
be removed
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- Select "undo" under Edit in the toolbar to undo the last trim. (This will only work if you have
Enabled Model Backups)
- You can also restore trimmed data through Regeneration of your scan found here: ->

Navigating
- Click on the "pointer button" before zooming or repositioning the object

- Drag object up/down while right clicking to zoom.
- Drag the object while holding down both mouse buttons to pan ->.
- Hold down center scroll to rotate object without selecting any areas.

When to Trim
- You can trim completed individual scans of 360/bracket scans while other scans are finishing.
- Before alignment you should not trim away parts of the object, only parts of the PartGripper.
- After alignment you can trim overlapping data to improve fusing/merging.
- Double click on the aligned family and drag the scan to be trimmed into the blue thumbnail bar

Next Step: Fuse your scans to remove any remaining overlap -> or align your scans if needed ->

AutoTrim
- Auto-trimming automatically detects and removes data that was captured at a steep angle relative to
the line of sight of the scanner.
- This can be useful in removing data that may negatively affect alignment or blending.
- Auto-trimming is available under the Polish menu and should be run before aligning, fusing or
merging multiple scans together.

- With this option selected you can choose the angle for trimming.
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If you have any further questions, please click on the Ask? button.
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3.6 Fuse
Fuse
The Fuse tool Volume Merges, Remeshes, Fills Holes and Simplifies your aligned scan data.
- Ensure that the data that you would like to fuse is aligned in the green section of the bottom view
bar.

Click Fuse

Choose Simplification Level

- Enter the desired deviation tolerance for any mesh simplification (decimation)
- 0.00" simplification will not simplify the data
- Increasing the simplification will simplify your model and make the file size smaller.
- It will perform intelligent simplification, which keeps more points in detailed areas and fewer points
in larger planes.

Click to enter Settings

- The Hole Filling Slider controls the max. circumference size of holes to fil.
- Control how much blending of the textures to perform (to account for brightness variations):
- Resolution Ratio determines the new average vertice length in relationship to the current length.
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- Values less than 1 will decrease your triangle size. Values greater than 1 will increase your triangle
size.
- It is best to keep this at the default of 0.9.

Click FUSE

A new family containing the Fused results is

Volume Merge
The Volume Merge tool eliminates the overlap from multiple scans and merges them into a single
mesh.
Volume Merge can be used in place of Fuse if you do not wish to Remesh or Hole Fill your scans.
To Merge multiple scans into a single mesh:
- Ensure that the scans to merge are in the green section of the bottom view bar.

Select Volume Merge
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Set the Resolution Ration

- Controls the size and amount of triangles that will be in the merged result.
- It is best to keep it at the default of 0.9.
- Values from 0-1 will result in smaller triangles than those presently in the scan.
- Values larger than 1 will result in larger triangles with a possible loss of detail.

A new family containing the Merged results is

The Merge process will not automatically fill holes in the mesh where there is no scan data.
You can use the Remesh option after a Merge to create a water-tight mesh (more info: ->).

Fusing Large Models
- The number of points that can be merged or fused at one time is dependant on the Computer Specs.
- To fuse/merge larger models we recommend these specs:
CPU:
Dual Core, Quad Core or i7 processor
Memory:
4+ GB RAM
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Graphics Card:
512+ MB GPU (Dedicated, non-integrated)
Operating System:
Windows XP 64 Bit
Windows Vista 64 Bit
Windows 7 64 Bit
You can check the number of points in your model under File->Model Information.

To reduce the number of points in your model Regenerate your data a higher simplification level.
See next section for instructions for regenerating.

Regenerate
Since the raw scan data is saved at scan-time, you can regenerate the points at any time with different
point-generation settings. These settings have the same effect as the sliders on the scan setup screen.
Re-Gen is particularly useful for changing the simplification value after a scan has been completed.
Steps:

Click on Fuse, Re-
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Select new settings for reprocessing

- Higher Simplification values will result in fewer points in the model.
- Simplification level of 2 will result in 1/4 of the original data, level 3 will result in 1/9 of original
data...
- Simplification can be increased and decreased at any time without losing original data.
- Restore Trimmed Data: Choose this option to restore the trimmed data from either a single scan,
family or the entire model.

Texture Quality
Texture Blending
- Prior to fusing there is overlap between scans.
- When you fuse a model the best 3D data for each point is kept and the rest is removed to create a
single mesh.
- There may be varying shadows on the final fused result depending on which 3D data and associated
texture remains post fuse.
Tips to improve textures:
- Ambient lighting- Minimizing the ambient lighting in the room can help improve textures.
- Object Distance- If you are repositioning the object make sure to keep the same approximate distance
to reduce color variation.
- Shadows- Try to minimize shadows as much as possible. Keep in mind the PartGripper can cause
shadows. Prior to scanning you can preview the rotation using the STEP and TURN buttons in the
scan panel. If necessary you can adjust the position of the rotations to reduce shadows. If you have a
single scan with an extreme shadow you can try to trim out the shadow as long as the data was capture
from a different angle.
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3.7 Polish
Hole Fill
- Enter the Polish panel.

- Select the Fill tool.

Holes are automatically detected

Note: Please make sure that when using the Fill tool, you are working with a fused, merged or a single
scan model.
- Use the selector tools to select the holes that you would like to fill.
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Selected holes will turn orange

- When you finish your selection(s), select the Fill button to permanantly commit these triangles into
your model.

After Fill
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Auto Hole Fill
To have ScanStudio automatically fill holes in the scan data:
- Ensure that the data that you would like to fill holes on is a volume merged model in the green
section of the bottom view bar.

- Select the Fill Holes tool from the Advanced Polish Menu.

- Enter desired Hole Filling Settings.

a. FILL METHOD:
- Flat Fill will fill the holes along a flat edge.
- Smooth Fill will fill the holes along a smooth edge.
- Curvature Fill will analyze the neighboring geometry and try to match the overall curvature.
b. MAX VERTICES: Controls the maximum number of vertices for holes to fill. Increase to fill more
holes.
c. LEAVE LARGEST: Enable this option to leave the largest hole in the scans.
d. SMOOTH BOUNDARIES: Enable this option to smooth the vertices on the edge of the holes as
part of the fill process.
You can also use the Remesh tool to automatically fill holes in merged data: ->
You can alternatively use the ScanStudio manual hole filling tool to manually select and fill holes
(more info: ->).
If you have any further questions, please click on the Ask? button.
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Buff
- Click on the Polish tool.

- Then click on the Buff tool.

Note: When buffing, please make sure that the model is a fused or merged model.
- Select localized data to smooth or all for the entire mesh.

Selected data will be highlighted red

Settings
3. Enter the desired buff options:
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a. Buff Method: Laplacian and Loop are two different smoothing methods. The Curvature option can
be used for curvature based smoothing.
b. Buff Weight: Increase to run a higher level of smoothing (when the Loop method is used, the
number of iterations is all that needs to be specified, the smoothing weight has no impact).
c. Deviation Tolerance: Optionally enter the allowable deviation for the smoothing.
d. Max Iterations: Increase to run more iterations of smoothing and therefore reduce more noise.
e. Smooth Boundaries: Enable this option to smooth vertices around the edges of holes.
f. Preserve Sharp Edges Enable this option to try and retain sharp edge detail.
Results

Before

57 of 120

After

If you have any further questions, please click on the Ask? button.

Simplify
Note: When using the Simplify tool, please make sure that you are working on a fused or merged
model. Simplifying prior to fusing/merging will create non-uniform mesh. Please regenerate scans if
you need to decrease model size before fusing (more info -> ).
- Click on the Polish tool.

- Click on the Simplify tool.

- Select the local data to simplify or select all.
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- Choose the desired simplification tolerance from the top menu bar slider.

- Click the SIMPLIFY button.

Before Simplify
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After Simplify

If you have further questions on the simplify tool, please click on the Ask? button.

Remesh
- Ensure that meregd or fused model is in the green section of the bottom view bar

Note: It is advised to remesh scans that have been merged/fused. For more info: ->.
- Select the Remesh tool from the Advanced Polish Menu.

Choose Remesh Settings

Resolution: Controls the size and amount of triangles that will be in the remeshed result.
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Values from 0-1 will result in smaller triangles than those presently in the scan.
Values larger than 1 will result in larger triangles with a possible loss of detail.
Fill Holes: Select the Hole Filling Settings to fill some or all holes.

Fill Method: You can experiment with the different fill methods to see which works best for your
model and the sizes and shapes of the holes.
Smooth Boundaries: Select this option to smooth the boundary of the newly filled holes.
Keep Largest Hole: If your object has an opening that is part of the design select this option to keep
that hole from filling.
Keep Holes Larger Than: If you don't want to fill all holes, then you can manaully set which holes
of circumference size to fill.
The Remesh tool can be very useful when run after Merging Scans to create a water-tight mesh.
If you have any further questions, please click on the Ask? button.

Clean Defects
Clean Defects should be run at the end of your polishing process and can be used to automatically
eliminate any self intersecting or non-manifold triangles.
To Clean Defects in your mesh:
1. Ensure that your Merged and Remeshed model or fused model is in the green section of the bottom
view bar.
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2. Select "Clean Defects" from the Polish - Advanced menu.

Any defects in the mesh will be automatically detected and cleaned.
If you have any further questions, please click on the Ask? button.
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3.8 Orient
The Orient Tool can be used to define an origin and Orient your scan data in a defined global
coordinate space.
- Click on the CAD button from the top toolbar to enter the CAD toolbar:

- Select Orient to enter the Orient toolbar:

- ScanStudio will show a bounding box representation of the common view planes (top, left, front,
etc.):

Settings

Rotate
- First option to rotate both bounding box with model
- Second option is to rotate the model with a fixed bounding box
- Third option is to rotate the bounding box with a fixed model
Constrain
- Use the constrain buttons to limit rotations on the x, y or z axis
Base
- Click the base button and place 3 pins on the object to define one of the common view planes of the
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bounding box:

Faces
- Click on faces to view the front, back, left, right, top and bottom locations

Origin
- Click on the origin button and place 1 pin on the mesh to define the origin.
Notes: Mesh scan data can be globally oriented, but CAD data cannot.
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3.9 Measure
Volume Measurement
- Ensure that your fused or merged and remeshed data is in the green section of the bottom view bar.
- Select Volume from the Measure menu:

- The calculated volume will be displayed:

- This tool is only available with the ScanStudio CadTools upgrade.
Surface Area Measurement
- Ensure that your fused or merged and remeshed data is in the green section of the bottom view bar.
- Select Surface Area from the Measure menu:

- The calculated surface area will be displayed:

Point to Point Measurement
- To measure a distance on a scan you can click on one point then press the letter "i" on your keyboard.
- This will give you the coordinates of that point.
- Then do the same at your second point and it will give you the new coordinates along with the
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distance to the previous point.
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3.10 Output
- Click the OUTPUT button to ouput the scan model.

-Choose the type of file you want to output

You can also export through the File-> Save As option.

Mesh Files

- ScanStudio HD allows the export of PLY, U3D, OBJ, XYZ, STL and VRML files.
NZIP Files
- An NZIP file is a compressed ScanStudio file that contains the SCN file and associated JPEGS
- It is useful if you need to transfer a scan file to a different computer.
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3D Print
Currently in development.
IGES and STEP Files
- Exporting IGES and STEP files is only available with ScanStudio CadTools.
- For more information about upgrading to CadTools please contact info@nextengine.com.
- Mesh data cannot be exported as an IGES/STEP file.
- Insure the model contains either splines or autosurfaces in the green section of the toolbar (for more
info click here ->).

Select

Name your scan, choose the ouput units, click

Rapidworks
- Directly transfer a fused or unfused model from ScanStudio to Rapidworks.
- Surfaces and Splines cannot be transferred.

Select Rapidworks
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- Output your currently loaded model as is.

- If you are exporting unfused scans, you have the option of Regenerating the scan data during the
export process.
- Choose to ouput the Selected Scan Family, Attached Data (in the green) or the Entire Model.
Solidworks
- Fused or merged scans can be directly transferred to Solidworks Office Premium.
- To enable the transfer the ScanTo3D add-in must be loaded in Solidworks.
- To load the add-in go to Tools-> Add-ins in Solidworks.
For more information on using your scan data in Solidworks click here ->.

69 of 120

Chapter 4

ScanStudio HD Add-Ons
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4.1 MultiDrive
Setup
-Here are the items that are included with the MultiDrive:

Allen wrench and

L Bracket

AutoPostioner

-Attach the L Bracket to the MultiDrive with two flat head screws and allen wrench

-Attach the MultiDrive to the bottom of the scanner and fasten a screw underneath the scanner for
additional stability
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-Plug in the MultiDrive to the scanner

-Start ScanStudioHD and proceed to Calibration

Calibration

When starting your first scan in

-"Start" to begin the automated calibration process (We suggesting using the palm tree included with
the MultiDrive)
-"Skip" if you wish to proceed to the scan panel and choose
-"Learn More" to be directed to this help page.

You can

-This function is available for re-calibration when alignment results in an error or when the MultiDrive
was detached and is reattached.

Scan Process

After calibration is
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A new scan panel will be loaded when

-Five families are now available for predefined settings for Positioning, Divisions, Start Angle, Tilt
Angle, Points/IN^2 and Target
-Clicking on the family name will enable the tab to edit the settings.
-To enable or disable a family, simply check or uncheck the circle next to the family name.
-Starting positions can be set for both the initial and tilt axis by moving the slider bar arrow.
-The start axis has the full 360 rotation and tilt axis is bounded to -35 to 45 degrees.
-Use the top slider bars to visually set the starting and tilt positions. (This will update the settings for
the scan family)

-Select the scan settings for each tab and check the tabs you want to have scan.
If the setting for a tab have been adjusted, but the tab is not checked it will not scan.
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-All MultiDrive scans are to be in MACRO mode.
-Select a ROI for your model to prevent the MultiDrive from being scanned in for certain tilt angles.
-If additional scans are needed, enter scan panel and position the model by using different starting and
tilt angles to capture additional scans.
-If you physically adjust the part, then a 3 pin alignment will be needed to align.
-When finished, trim unnecessary data and "Fuse" or "Volume Merge" the model for export: ->

Troubleshooting
Switching between AutoDrive and MultiDrive
- Simply plug in an AutoDrive to display the proper UI.
- When reattaching the MultiDrive, make sure to recalibrate as needed.
-When more than 5 Scan families are required, then just click on scan to enter the scan panel, and you
can add 5 more new sessions. These scans should auto align to the previous scans assuming all the
movement and rotations were done by the turntable. If they don't auto-align , just drag the scans into
the green and refine (no pins required)
-Force Calibration. If your scans are not coming in aligned, you may need to run a force calibration.
You can do this from the drop down menu , Align, then go down to Calibrate MultiDrive

Dental
Recommended Scan Settings for Dental Cast Models
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Family A Divisions: 6 Tilt: -10

Family B Divisions: 6 Tilt: 45 degrees

-Use the HD speed for higher resolution
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4.2 HD PRO

SCANSTUDIO HD PRO
4x Data Capture
HD scan speed allows for a maximum point cloud resolution of .0025", thereby capable of capturing
finer details and smaller objects.
Extended Wide Mode Scanning
In the scan panel select Extended mode ito increase the depth range to 30 inches from the scanner.
The maximum field of view in Extended mode is 16 x 20". There will be a degradation in the accuracy
of the scan results at these distances, it is suggested that you scan white objects for best results.
Faster Laser Scan Time
With HD PRO activated the laser scan time is nearly twice as fast.
Activating HD PRO
To activate HD PRO click on Help>My Software and activate on the My Software page.
To purchase the HD PRO license visit the buy page here.
This software requires an HD capable scanner. For more information click the ASK button
below.
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4.3 CAD Tools
Intro

SCANSTUDIO CAD TOOLS
Auto Surfacing
1 - Button creation of NURBS surfaces. CAD TOOLS creates a patch network of surfaces on your
mesh models for easy IGES and STEP export.
Spline Creation
Defined spacial splines can be created with ease. Simple curves are traced from your mesh models
and are great for referencing size and shape.
File Export
Easy output of Splines and Surfaces as IGES or STEP.
Activating CAD TOOLS
To activate CAD TOOLS click on Help>My Software and activate on the My Software page.
To purchase the CAD TOOLS license visit the buy page here.
For more information click the ASK button below.

Spline
The Spline Tool can be used to extract boundary curves from your mesh data.
- Ensure that the Fused mesh data that you wish to convert to splines is in the green section of the
bottom view bar.
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Select CAD

Select SPLINE

- ScanStudio will automatically calculate and display a bounding box which can be used to define the
plane cuts to use to extract the boundary splines:

AXIS button to change which face from

SPACING slider to control how far apart

The BOUNDS tool to control which

ORIENT tool to position the mesh data
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Use the Rotate tools to move either the mesh data, the bounding box, or both.
The Constrain tools can be used to limit rotation along a particular axis.
The Base tool can be used to define one of the planes in the bounding box by placing pins on the
mesh

Click SPLINE to complete

The set of splines created will be added to a common "Spline" family off of the root of the model.

AutoSurface
The AutoSurface Tool will automatically create a patch network of surfaes from the mesh model.
This can be easily exported as an IGES or STEP file.
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- Ensure that you have merged results in the green section of the bottom view bar:

Select CAD

Select

Choose the Number of

More surfaces may result in more accuracy.
If the resulting surfaces have missing data then try increasing the number of surfaces.

Click SURFACE

-The resulting surfaces are stored in the SCN file and displayed

Output
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- Exporting IGES and STEP files is only available with ScanStudio CAD TOOLS.
- For more information about upgrading to CadTools please contact info@nextengine.com.
- Mesh data cannot be exported as an IGES/STEP file.
- Insure the model contains either splines or autosurfaces in the green section of the toolbar

Select Output

Select

Alternate Export

Name your scan, choose the ouput units, click
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4.4 ProCare

ScanStudio HD ProCare
- Extended 3 years of Online Support through the NextWiki Support Center with access to Technical
Support and Online Documentation.
- Standard Technical Support terms end after 1 year, Online Documentation will remain available for
reference.
- Live online chat with expert Applications Engineers who can help with troubleshooting, scanning
tips and custom workflow documents for your individual application.
ScanStudio HD ProCare Pricing
$295 - ScanStudio HD ProCare must be purchased within 90 days of original Scanner purchase.
To purchase the ScanStudio HD ProCare visit the buy page here.
For more information click the ASK button below.
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Chapter 5

Rapidworks
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5.1 Importing Scans
IMPORTING SCANS TO RAPIDWORKS

Select INSERT and

Under Construction...
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5.2 Mesh Modeling
MESH BUILDUP WIZARD
Coming Soon
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5.3 Surface Modeling
AUTO SURFACING IN RAPIDWORKS
Coming Soon

86 of 120

5.4 ProCare

Rapidworks ProCare
- 3 years of Major and Minor Updates to RapidWorks
- Access to the Rapidworks Success site with over 18 hours of full-screen HD video tutorials and
sample files made by expert Rapidworks users.
- Access to the support engineers at Rapidform for more personalized help with models.
RapidWorks ProCare Pricing
- Within 90 days of RapidWorks purchase = $995
- 90 days - 6 months = $1295
- 6 months - 1 year = $1500
- 1 year - 2 years = $1750
- 2 years - 3 years = $2000
- After 3 years = $2495
Rapidworks ProCare can be purchased at www.nextengine.com/buy
Upon purcashing ProCare, e-mail support@rapidworks3d.com or call (408) 856-6200 x2 to sign up
for the Rapidworks Success website.
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5.5 Solid Modeling
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Chapter 6

Other 3D Programs
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6.1 SolidWorks

http://www.solidworks.com/
-Solidworks Premium (and Educational version)
The Scanto3D Add-In allows you to import and reference mesh scan data in your 3D design.
-Other Solidworks Versions (Standard/Professional)
If you do not have the Premium version and the Scanto3D Add-In you can use ScanStudio CAD
TOOLS -> to create surfaces or spines from your scan data, and then export the surfaces or splines as
IGES or STEP.
You can also use RapidWorks -> , which allows the user to recreate a Solid Model from the Scan data,
then export a fully featured part into SolidWorks native SLDPRT file format.
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6.2 RapidForm XO

Rapidform XOR2
Rapidform XOV2
Rapidform XOS
InspectWorks
Rapidform Explorer
http://www.rapidform.com
Rapidform XOR2
-Go to Insert - Import and under the dropdown for file type select NextEngine files (*.scn):
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6.3 Geomagic

http://www.geomagic.com/en/
Geomagic Studio
"Transform 3D Scan Data into Accurate Digital Models. Designed to handle the most demanding
reverse engineering, product design and rapid prototyping challenges, Geomagic Studio transforms 3D
scan data and polygon meshes into accurate 3D digital models. A perfect complement to the CAD,
CAE and CAM tools you already own, Studio outputs industry standard formats including STL, IGES,
STEP and native CAD files."
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6.4 ArtCAM

ArtCAM
http://www.artcam.com/
Here is a great new Forum from users combining the NextEngine 3D Scanner and ArtCAM:
http://forum.artcam.com/viewtopic.php?f=5&t=8143
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6.5 Mesh Lab

MeshLab
http://meshlab.sourceforge.net/
"MeshLab is an open source, portable, and extensible system for the processing and editing of
unstructured 3D triangular meshes.
The system is aimed to help the processing of the typical not-so-small unstructured models arising in
3D scanning, providing a set of tools for editing, cleaning, healing, inspecting, rendering and
converting this kind of meshes."
Imports all mesh files; STL, OBJ, PLY, XYZ, VRML ->

94 of 120

6.6 Magics

MATERIALIZE MAGICS
http://www.materialise.com/materialise/view/en/2408555-Magics.html
- Software for the Rapid Prototyping and Manufacturing Professional.
- Import VRML, STEP and IGES files from ScanStudio HD and ScanStudio CAD Tools into
Magics.
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6.7 Maya

AUTODESK MAYA
http://usa.autodesk.com/adsk/servlet/pc/index?siteID=123112&id=13577897
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6.8 MudBox

Mudbox
http://usa.autodesk.com/adsk/servlet/pc/index?siteID=123112&id=13565928
"AutoDesk Mudbox software is an advanced, high-resolution, brush-based digital 3D sculpting and 3D
painting solution. Mudbox features and functionality address the needs of professional modelers
working in the game, film, television, and design industries."
-You will need to export your model from ScanStudio as an OBJ file. ->
-Select 'Open a File...'

-OBJ File Loaded into Mudbox

-Using the sculpting tools you can quickly redesign your model
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6.9 ZBrush

ZBrush
"ZBrush is a digital sculpting and painting program that has revolutionized the 3D industry with its
powerful features and intuitive workflows. Built within an elegant interface, ZBrush offers the world's
most advanced tools for today's digital artists. With an arsenal of features that have been developed
with usability in mind, ZBrush creates a user experience that feels incredibly natural while
simultaneously inspiring the artist within. With the ability to sculpt up to a billion polygons, ZBrush
allows you to create limited only by your imagination."
Check out the website for full details, gallery, and to download a 30-day trial.
http://www.pixologic.com/home.php
To Load your scan model in ZBrush you will need to export your model as a STL or OBJ file >
After opening Software Select Open Model (STL or OBJ)

Select the STL/OBJ file from the directory and the model will load in the app:
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6.10 Blender

Blender
http://www.blender.org/
"Blender is the free open source 3D content creation suite, available for all major operating systems
under the GNU General Public License."
Download Blender here:
http://www.blender.org/download/get-blender/
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6.11 AutoDesk
You can now import IGS files by installing Parasolid Plug-In on the Autodesk Labs site.
Here is the link : http://labs.autodesk.com/utilities/translator_add-ins_for_autodesk_/
You can access the translator using the standard Open command in Inventor. You can choose various
file types to open and in this case I chose IGES as the file type. Once a file is selected you can choose
the Options button on the Open dialog. For IGES files youll get the dialog below.

If it is water tight it will result in a solid as seen below.

If the objects have holes they will import in as surfaces. The result ended up in Inventors Construction
environment with the idea that you can use the tools there to clean up the model and import it into
Inventors parameter environment as either a solid or as a surface. The picture below shows the
Blackberry in the construction environment.
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6.12 Rhino

http://www.rhino3d.com/
You can open your SCN files directly in Rhino 4.0 by downloading the SCN file importer plugin
from:
http://en.wiki.mcneel.com/default.aspx/McNeel/NextEngine.html
If you do not have the plug-in installed, or if you are using Rhino 3.0, you will need to export
your scans as an OBJ or STL file. ->
Inside ScanStudio:
1. Make sure the model is fused. ->
2. Drag the blended family thumbnail into the green side of the bottom view bar.
3. If you have the SCN importer for Rhino 4.0, simply save your SCN file and then open it in Rhino.
If you do not have the SCN importer, then goto File > Save As > and change the file type to OBJ and
save an OBJ file.
Inside Rhino:
Please download the following tutorials for information on working with imported meshes in
Rhinoceros:
http://www.nextengine.com/Rhino_Scan_Remodel.pdf
http://download.mcneel.com/download.asp?id=STLRepair
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6.13 Mathematica

Mathematica
http://www.wolfram.com/products/mathematica/index.html
STL model loaded as 3D Graphic in Mathematica
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6.14 3D Studio Max

http://www.resources.autodesk.com/med/Autodesk_3ds_Max
OBJ Scan Model Loaded in 3D Studio Max
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Chapter 7

Reference

106 of 120

7.1 User License Agreement
NEXTENGINE, INC. SOFTWARE LICENSE AGREEMENT 3D DESKTOP SCANNER AND
SCANSTUDIO SOFTWARE PRODUCTS
These license terms are an agreement between you and NextEngine, Inc. Please read them. They apply
to the software that accompanies these license terms, which includes the media on which you received
it, if any, your 3D Desktop Scanner device, and accessories. The terms also apply to any NextEngine
updates, supplements, Internet-based services, and support services for this software and the
accompanying licensed device, unless other terms accompany those items. If so, those terms apply.
BY CLICKING ON THE AGREE BUTTON BELOW, YOU ACKNOWLEDGE THAT YOU HAVE
READ THIS AGREEMENT, UNDERSTAND IT, AND AGREE TO THESE TERMS. IF YOU DO
NOT ACCEPT THE TERMS, NEXTENGINE DOES NOT LICENSE THE SOFTWARE TO YOU,
AND YOU SHOULD CLICK ON THE "DON'T AGREE" BUTTON BELOW TO DISCONTINUE
THE INSTALLATION PROCESS.
AS DESCRIBED BELOW, USING THE SOFTWARE ALSO OPERATES AS YOUR CONSENT
TO THE TRANSMISSION OF CERTAIN COMPUTER INFORMATION DURING ACTIVATION,
VALIDATION, AND FOR INTERNET-BASED SERVICES.
IF YOU COMPLY WITH THESE LICENSE TERMS, YOU HAVE THE RIGHTS BELOW FOR
EACH LICENSE YOU ACQUIRE.
1. OVERVIEW.
This software package contains multiple products (e.g. ScanStudio CORE, ScanStudio HD,
ScanStudio HD PRO, ScanStudio CAD Tools, etc.), each of which is separately purchased and
activated. These products are licensed for nodelocked use from a single installation, as defined by this
license agreement. For the avoidance of doubt, the products in this software package must be installed
onto the same computer, and the individual products cannot be split up and installed onto separate
computers.
2. INSTALLATION, LICENSING REQUIREMENTS, AND USE RIGHTS.
a. Software Installation.
The software license is permanently assigned to the 3D Desktop Scanner device with which you
acquired the software. That device is the licensed device. You may install and use the software only
from a single computer that is owned and controlled by you.
b. Acceptable Use.
You agree to install, maintain, and use the software according to the documentation supplied by
NextEngine; to follow NextEngine's instructions for installing updates and upgrades and for correcting
and circumventing bugs; and to abide by all of the terms of this license agreement.
c. Term and Termination.
This license agreement is effective until terminated. You may terminate it at any time by destroying all
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copies and portions of the software and documentation. It will also terminate immediately if you fail to
comply with any term or condition of this license agreement. Upon such termination, you agree to
destroy all copies and portions of the software and documentation.
d. Separation of Components.
The components of the software are licensed as a single unit. You may not separate the components
and install them on different devices.
e. Remote Access.
The single primary user of the licensed device may access and use the software remotely from the
computer. You may allow other users to access the software to provide you with support services. You
do not need additional licenses for this access. No other person may use the software under the same
license at the same time for any other purpose.
f. Sample and Tutorial Files.
You may copy and use the sample and tutorial files provided with the software for your own personal
training purposes only, unless permission is otherwise granted in writing by NextEngine.
g. Trial and Conversion.
Some or all of the software may be licensed on a trial basis. Your rights to use trial software are
limited to the trial period. The trial software and length of the trial period are set forth during the
activation process. You may have the option to convert your trial rights to perpetual rights. Conversion
options may be presented to you at the expiration of your trial period. After the expiration of any trial
period without conversion, most features of the trial software will stop running.
h. Development Tools.
The software may contain a software development kit (SDK), including code libraries and
development tools. You may only use this SDK to design, develop, test, use, and demonstrate your
programs with the software.
i. Pricing and Payment.
Fees for the license granted hereunder shall be due before licensing unless otherwise negotiated with
NextEngine. The effectiveness of the licenses granted hereunder is conditioned on the receipt by
NextEngine of all applicable fees.
3. SOFTWARE ACTIVATION.
Activation associates the use of the software with you, a specific licensed device, and with a specific
computer. During activation, the software may send information about the software, licensed device,
user, and computer to NextEngine. This information includes the version, language and the product ID
of the software, Internet protocol address of the computer, and information derived from the hardware
configuration of the device. By using the software, you consent to the transmission of this information.
Some changes to your computer components or the software may require you to reactivate the
software.
The software may verify from time to time that it has been activated and properly licensed. During a
validation check, the software may send information about the software, licensed device, user, and
computer to NextEngine. BY USING THE SOFTWARE, YOU CONSENT TO THE
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TRANSMISSION OF THIS INFORMATION. If the software is not properly licensed, the
functionality of the software may be affected. For example, you may need to reactivate the software,
or receive reminders to obtain a properly licensed copy of the software, or not obtain certain updates,
upgrades or services from NextEngine.
4. COMPLIANCE WITH LICENSES.
If you are a business or organization, you agree that:
a. Upon request from NextEngine or NextEngine's authorized representative, you will document and
certify within thirty (30) days that your use of NextEngine software at the time of the request is in
conformity with your licenses granted by NextEngine.
b. NextEngine may, at its expense, direct a recognized independent accounting firm to audit, during
normal business hours, the number of persons using the software. Representatives of the auditing firm
shall protect the confidentiality of your information and abide by your reasonable security regulations
while on your premises. If your use exceeds the terms of this license agreement, then you will be
invoiced for any additional license fees necessary to bring you into compliance. This invoice shall be
payable within fifteen (15) days of delivery. If the amount of such invoice is greater than five percent
(5%) of the aggregate amount of all license fees paid or payable by you to the date of the audit, you
will pay all expenses associated with such audit.
5. INTERNET-BASED SERVICES.
NextEngine may provide Internet-based services with the software, and NextEngine may change or
cancel these services at any time. These software features connect to NextEngine or service provider
computer systems over the Internet and may transmit information pertaining to your computer,
licensed device, software, usage, user, software errors, and bugs. BY USING THE SOFTWARE,
YOU CONSENT TO THE USE OF THESE SERVICES AND TRANSMISSION OF THIS
INFORMATION.
You may not use these services in any way that could harm them or impair anyone elses use of them.
You may not use the services to try to gain unauthorized access to any service, data, account or
network by any means.
6. SCOPE OF LICENSE.
The software is licensed, not sold. This agreement only gives you some rights to use the software.
NextEngine reserves all other rights.
Title, ownership rights, and intellectual property rights (including without limitation all applicable
rights to patents, copyrights, trademarks and trade secrets inherent therein and appurtenant thereto) in
and to the software (including without limitation any images, data, animations, video, audio, music,
and text incorporated into the software), and all copies of the software, are owned by NextEngine
and/or its licensor(s), as applicable, and are protected by U.S. copyright laws and international
copyright treaties, as well as other intellectual property laws, treaties, and federal and state trade secret
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laws. Nothing in this license agreement constitutes a waiver of NextEngine's rights under U.S. or
international copyright law or any other federal or state law.
Unless applicable law gives you more rights despite this limitation, you may use the software only as
expressly permitted in this agreement. In doing so, you must comply with any technical limitations in
the software that only allow you to use it in certain ways. For more information, see the software
documentation.
You may not:
work around any technical limitations in the software; reverse engineer, decompile, disassemble, or
reduce the software to human-perceivable form, except and only to the extent that applicable law
expressly permits, despite this limitation; modify, adapt, translate, or create derivative works except as
authorized by the documentation; remove any proprietary notices or labels on the software, make more
copies of the software than specified in this agreement or allowed by applicable law, despite this
limitation; publish the software for others to copy; use the software in any way that is against the law;
rent, lease, lend, sublicense, or otherwise transfer any or all of the software or rights granted by this
license agreement except as expressly provided herein; or use the software for commercial online
services, service bureau, or time-share services to third parties without NextEngine's prior written
consent, which may be withheld or denied in NextEngine's sole and absolute discretion, and is subject
to payment of such additional license fees as NextEngine may require.
7. DERIVATIVE WORKS.
You agree that NextEngine owns all rights, title, and interest in and to any changes or suggested
changes made by you to the software, and you agree to execute any and all assignments or other
documents necessary to convey such ownership rights to NextEngine.
8. BACKUP COPY.
You may make one backup copy of the software media and use it only to reinstall the software.
9. DOCUMENTATION.
Any person that has valid access to your computer or internal network may copy and use the
documentation for your internal, reference purposes.
10. TRANSFER TO A THIRD PARTY.
You may transfer the software directly to a third party only with the licensed device and this
agreement. Before the transfer, that party must agree that this agreement applies to the transfer and use
of the software. You may not retain any copies.
All software licenses are bound to the licensed device. Sale of the licensed device automatically
conveys all software licenses associated with the device to the new device owner. You may not sell
the software products separately from the licensed device.
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11. UPGRADE OR CONVERSION.
To upgrade or convert software, you must first be licensed for the software that is eligible for the
upgrade or conversion. Upon upgrade or conversion, this agreement takes the place of the agreement
for the software you upgraded or converted from. After you upgrade or convert, you may no longer
use the earlier version of the software you upgraded or converted from.
Minor software updates and bug fixes may be available at no cost, while major software upgrades may
require purchase. You may only obtain updates or upgrades for the software from NextEngine or
authorized sources.
12. EXPORT RESTRICTIONS AND LEVIES.
The software is subject to United States export laws and regulations. You must comply with all
domestic and international export laws and regulations that apply to the licensed device and associated
software. These laws include restrictions on destinations, end users, and end use.
You are responsible for obtaining all required government authorizations to purchase and use the
licensed device and software, including, without limitation, any export or import licenses and foreign
exchange permits. NextEngine shall not be liable if any such authorizations are delayed, denied,
revoked, restricted, or not renewed, and you shall bear all risks and costs associated with such
activities.
If you are importing or exporting the Software outside of the United States, you agree to indemnify
and hold NextEngine harmless from and against any import and export duties or other claims arising
from such importation or exportation. You shall be responsible for payment of all taxes, fees,
assessments, or levies on the software, or arising out of or imposed by reason of this agreement or the
license granted hereunder, except for any tax based on NextEngine's annual net income.
13. SUPPORT SERVICES.
NextEngine provides online and phone support within the first twelve (12) months of the original
purchase of your licensed device and software products from NextEngine. This support is nontransferrable and immediately terminated if the licensed device is resold by the original owner.
Additional support options may be available for purchase from NextEngine. Contact NextEngine for
additional information.
14. GOVERNMENT END USERS.
The license granted under this License Agreement does not constitute a response by NextEngine to
any request for proposals, bid solicitation or other invitation or offer to contract by any governmental
authority but instead constitutes an offer to enter into a license agreement only upon the terms and
conditions set forth herein. If the United States Government or any other governmental authority shall
seek to acquire the Software and its acquisition of such Software would result in the U.S. Government
or such other governmental authority having rights in any software that are at variance with the terms
and conditions of this License Agreement, NextEngine shall not be bound by any such rights unless it
shall have expressly entered into an amendment of this License Agreement that shall set forth such
rights in accordance with any applicable governmental rules or regulations, including the Federal
Acquisition Regulation and the Defense Federal Acquisition Regulation Supplement. The Software is
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a "commercial item," as that term is defined in 48 C.F.R. 2.101. The contractor/manufacturer is
NextEngine, Inc., 401 Wilshire Boulevard, Ninth Floor, Santa Monica, CA 90401.
15. ENTIRE AGREEMENT.
This agreement (including the warranty below), any addendum or amendment included with the
software, and the terms for supplements, updates, Internet-based services and support services that you
use, are the entire agreement for the software and support services and supersedes all previous and
contemporaneous communications, presentations, quotations, or agreements regarding the subject
matter hereof.
No waiver, alteration, modification, or cancellation of any of the provisions of this license agreement
shall be binding unless made in writing and signed by an authorized officer of NextEngine.
16. APPLICABLE LAW.
This license agreement is governed by the laws of the State of California without regard to its conflict
of laws principles. You consent to the jurisdiction and venue in the state and federal courts sitting in
Los Angeles, California.
17. SURVIVAL.
The obligations of confidentiality and indemnification and other restrictions contained in this license
agreement, but not the license to use the software, shall survive the termination of this license
agreement.
18. EQUITABLE RELIEF.
You agree that NextEngine shall be entitled to obtain injunctive relief against you, in addition to any
other remedies to which it may be entitled, to enforce the terms and conditions of this license
agreement and to protect NextEngine's proprietary rights in the software.
19. WAIVER.
No failure or delay on the part of any party in exercising any right or remedy provided in this license
agreement shall operate as a waiver thereof; nor shall any single or partial exercise of or failure to
exercise any such right or remedy preclude any other or further exercise thereof or the exercise of any
other right or remedy under this license agreement.
20. SEVERABILITY.
If any provision of this license agreement is held by a court of competent jurisdiction to be illegal,
invalid or unenforceable, the remaining provisions shall remain in full force and effect.
112 of 120

21. LEGAL EFFECT.
This agreement describes certain legal rights. You may have other rights under the laws of your state
or country. You may also have rights with respect to the party from whom you acquired the software.
This agreement does not change your rights under the laws of your state or country if the laws of your
state or country do not permit it to do so.
22. INDEMNIFICATION.
You agree to hold harmless, indemnify, and defend NextEngine, its officers, directors, employees, and
agents, from and against any loss, claim, or damages (including reasonable attorneys' fees) arising out
of or relating to any claim:
that you have encoded, compressed, copied, or transmitted any materials (other than the materials
provided by NextEngine) in connection with the software; that you have used the software in violation
of another party's rights or in violation of any law; that you have misused, allowed to be misused or
modified the software in any manner not expressly permitted by this license agreement; or that any
content added to or incorporated into the software by you infringes any intellectual property rights of
any third party.
23. HEADINGS.
The headings in this license agreement are for purposes of reference only and shall not in any way
limit or affect the meaning or interpretation of any of the terms hereof.
24. LIMITATION OF LIABILITY.
IN NO EVENT WILL NEXTENGINE BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL OR PUNITIVE DAMAGES, OR ANY DAMAGES RELATED
TO LOSS OF USE, DATA, SOFTWARE, BUSINESS, PROFITS OR GOODWILL, WORK
STOPPAGE, OR ANY OTHER COMMERCIAL DAMAGES OR LOSSES, ARISING IN
CONTRACT, TORT OR OTHERWISE, EVEN IF NEXTENGINE HAS KNOWLEDGE OF THE
POTENTIAL LOSS OR DAMAGE. NEXTENGINE SHALL NOT BE LIABLE FOR DAMAGES,
CLAIMS BY THIRD PARTIES OR ANY OTHER CLAIM FOR ANY CAUSE WHATSOEVER,
REGARDLESS OF THE FORM OF ACTION, ARISING MORE THAN ONE (1) YEAR AFTER
THE DISCOVERY OF THE DEFECT RESULTING IN ANY SUCH DAMAGE. YOU ACCEPT
THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT WITH THE
UNDERSTANDING THAT NEXTENGINE'S LIABILITY IS LIMITED, THE FEES PAYABLE
HEREUNDER HAVE BEEN AND WILL BE CALCULATED ACCORDINGLY, AND THAT YOU
MAY REDUCE YOUR RISK FURTHER BY MAKING APPROPRIATE PROVISION FOR
INSURANCE. YOU FURTHER AGREE TO MITIGATE ALL LOSSES OR DAMAGES.
NextEngines total liability to you for actual damages for any cause whatsoever will be limited to the
greater of $500 or the amount paid by you for the software that caused such damage.
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This limitation applies to anything related to the software, services, content (including code) on third
party Internet sites, or third party programs; and
claims for breach of contract, breach of warranty, guarantee or condition, strict liability, negligence, or
other tort to the extent permitted by applicable law.
It also applies even if repair, replacement or a refund for the software does not fully compensate you
for any losses; or
the manufacturer or installer, or NextEngine knew or should have known about the possibility of the
damages.
Some states do not allow the exclusion or limitation of incidental or consequential damages, so the
above limitation or exclusion may not apply to you. They also may not apply to you because your
country may not allow the exclusion or limitation of incidental, consequential or other damages.
LIMITED WARRANTY
A. LIMITED WARRANTY.
If you follow the instructions, the software will perform substantially as described in the NextEngine
materials that you receive in or with the software.
B. TERM OF WARRANTY; WARRANTY RECIPIENT; LENGTH OF ANY IMPLIED
WARRANTIES.
THE LIMITED WARRANTY COVERS THE SOFTWARE FOR 30 DAYS AFTER ACQUIRED BY
THE FIRST USER. If you transfer the software, the remainder of the warranty will apply to the
recipient.
TO THE EXTENT PERMITTED BY LAW, ANY IMPLIED WARRANTIES, GUARANTEES OR
CONDITIONS LAST ONLY DURING THE TERM OF THE LIMITED WARRANTY. Some states
do not allow limitations on how long an implied warranty lasts, so these limitations may not apply to
you. They also might not apply to you because some countries may not allow limitations on how long
an implied warranty, guarantee or condition lasts.
C. EXCLUSIONS FROM WARRANTY.
This warranty does not cover problems caused by your acts (or failures to act), the acts of others, or
events beyond the reasonable control of the manufacturer or installer, or NextEngine.
D. REMEDY FOR BREACH OF WARRANTY.
NEXTENGINE WILL, AT ITS ELECTION, EITHER (I) REPAIR OR REPLACE THE SOFTWARE
AT NO CHARGE, OR (II) REFUND THE AMOUNT PAID FOR THE PRODUCT, IF ANY.
NEXTENGINE MAY ALSO REPAIR OR REPLACE SUPPLEMENTS, UPDATES, AND
REPLACEMENT SOFTWARE, OR PROVIDE A REFUND OF THE AMOUNT YOU PAID FOR
THEM, IF ANY. THESE ARE YOUR ONLY REMEDIES FOR BREACH OF THE LIMITED
114 of 120

WARRANTY.
E. CONSUMER RIGHTS NOT AFFECTED.
YOU MAY HAVE ADDITIONAL CONSUMER RIGHTS UNDER YOUR LOCAL LAWS, WHICH
THIS AGREEMENT CANNOT CHANGE.
F. WARRANTY PROCEDURES.
Contact NextEngine to find out how to obtain warranty service for the software. For a refund, you
must comply with the NextEngines return policies.
G. NO OTHER WARRANTIES.
THE LIMITED WARRANTY IS THE ONLY DIRECT WARRANTY FROM NEXTENGINE.
NEXTENGINE GIVES NO OTHER EXPRESS WARRANTIES, GUARANTEES OR
CONDITIONS. WHERE ALLOWED BY YOUR LOCAL LAWS, NEXTENGINE EXCLUDES
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NON-INFRINGEMENT. If your local laws give you any implied warranties, guarantees or
conditions, despite this exclusion, your remedies are described in the remedy for breach of warranty
clause above, to the extent permitted by your local laws.
H. LIMITATION OF LIABILITY FOR BREACH OF WARRANTY.
THE LIMITATION OF LIABILITY CLAUSE ABOVE APPLIES TO BREACHES OF THIS
LIMITED WARRANTY.
THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE
OTHER RIGHTS WHICH VARY FROM STATE TO STATE. YOU MAY ALSO HAVE OTHER
RIGHTS WHICH VARY FROM COUNTRY TO COUNTRY.
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